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Copyright
No part of this document may be reproduced or transmitted in any form or by 
any means, electronic or mechanical, including photocopying and recording, 
for any purpose without the express written consent of Boris FX.

Copyright © Boris FX 2023. All Rights Reserved

January 19, 2024

About Us
Founded in 1995, Boris FX is a leading developer of VFX, compositing, titling, 
video editing, and workflow tools for broadcast, post-production, and film 
professionals. Boris FX products have grown to serve over a million artists 
worldwide. The company’s success lies in its ability to tightly integrate and 
leverage technologies through strong partnerships with Adobe, Apple, Avid, 
Blackmagic Design, Autodesk, FilmLight, Grass Valley, Magix, SGO, and other 
leading developers of video editing software. In 2014, Boris FX acquired 
Imagineer Systems, the Academy Award-winning developer of Mocha planar 
tracking software. In 2016, Boris FX acquired GenArts, the developer of 
Sapphire, the gold standard plug-in package for high-end visual effects. In 
2019, Boris FX acquired the Academy Award-winning Silhouette for advanced 
feature film rotoscoping, painting, and effects.
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 SILHOUETTE 2023.5.4 - 1/19/24

Features
Denoiser ML - New v2.1 Models

Denoiser ML includes new and improved v2.1 models.

Bug Fixes
Denoiser ML - Solid Saturated Colors Noisier In v2 Models

When using the v2 models, solid saturated colors were much noisier than the 
v1 models. New v2.1 models are included which solve this problem.

Silhouette After Effects Plug-in Imported Optional Sources 
As Single Frames

A recent After Effects update caused the Silhouette plug-in to import the 
optional sources as single frames.
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Known Issues / Limitations
GStreamer

ProRes
All ProRes movies are imported as 16-bpc. This is a limitation of the GStreamer 
ProRes decoder.

Rendering Interlaced Footage
Rendering interlaced footage is not supported at this time.

ML Plug-ins
Because of the computation and memory requirements, the ML plug-ins require 
NVIDIA Pascal architecture cards or better for machine learning nodes.

OpenColorIO - Particle Illusion and Flare Editor
OpenColorIO is not implemented in Particle Illusion or the Lens Flare > Flare 
Editor which results in the image in those interfaces not exactly matching the 
Silhouette viewer.

Power Mesh
The Power Mesh node renders a slightly different result than Mocha Pro.

Silhouette Plug-in
Flame
Upstream Node Changes Don’t Update Until Silhouette Is Opened
Upstream node changes in Flame don’t update when viewing the Silhouette 
plug-in unless Purge Cache is selected, the Render menu is toggled or 
Silhouette is opened.

Sequence Numbering
Flame is not obeying the OFX parameter that determines the start frame, so a 
Flame sequence starting at 1 instead starts at 0 in Silhouette.

Multiple Instances of Silhouette Plug-in
You can’t connect two Silhouette plug-ins in a row. There can be multiple 
Silhouette plug-ins, just not chained together.
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Premiere Pro
Alpha Channels With Soft Edges
By default, Premiere Pro is linearizing the alpha channels exported from the 
Silhouette plug-in even though they are already linear. This causes the alpha 
to appear smaller when using soft edges. To avoid this issue, disable 
Composite in Linear Color in the Premiere sequence settings.

Misreporting The Resolution
Silhouette requires that Premiere Pro’s Playback Resolution be set to Full. 
Otherwise, an error message is displayed when opening the Silhouette user 
interface. In addition, sometimes Premiere Pro misreports the correct 
resolution even though it is set to Full. If this happens, change to a different 
frame and try again. Adobe is aware of this issue.

Trimmed Footage Loads The Entire Clip Into Silhouette
If a clip is trimmed in Premiere Pro, the entire clip is loaded into the Silhouette 
plug-in instead of the trimmed clip. Adobe is aware of this issue.

Resolve > Multiple Inputs
Resolve does not allow more than one input for plug-ins that use custom user 
interfaces. However, additional sources can be added directly within Silhouette.
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 SILHOUETTE 2023.5.3 - 12/15/23

Features
Cache > Render Server Preferences

The following Cache > Render Server preferences used by the Silhouette plug-
in were added: 

Render Server > % Physical Memory
Sets the maximum image cache as a percentage of physical memory. The 
default is 10%.

Render Server > IPC Buffer Size
Sets the buffer size for both input and output between the host and the plug-in. 
The default is 500MB.

Improvements
Sped Up ML Node Model Loading On MacOS 14

ML node model loading was drastically sped up on macOS 14.

Bug Fixes
Imported Nodes Didn't Finalize

Importing .sfxnodes either through the Trees window or from scripting did not 
properly finalize the import, so the nodes had a bad state.

Silhouette Crashed With ML Nodes In Nuke (Linux)
As of Silhouette 2023.5.1, adding a ML node in Nuke on Linux caused 
Silhouette to crash.

Projects With A . In The Name Not Supported
Users wanted to have projects named Project.v2.sfx, but Silhouette didn’t 
properly handle the .v2 in the name, especially when saving via scripting.
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Undo Issue With Dot Nodes
The Undo system got out of sync when manipulating Dot nodes.

Sapphire’s OpenColorIO Filter Caused Project To Not Load
Sapphire’s OpenColorIO filter produced a malformed error when loading the 
project.
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 SILHOUETTE 2023.5.2 - 12/1/23

Bug Fixes
Magic Sharp Had No Effect

Magic Sharp had no effect.

Plug-in Render In Host Was Slow With Large Image Sizes
The passing of images as well as rendering from Silhouette to the host 
application was slow when using large images. The memory buffer size was 
increased to 200MB to solve this issue. This value can be overridden with the 
SFX_SERVER_IPC_BUFFER_SIZE environment variable.

Python bz2 Support Was Not Working On Linux
The bz2 module was not working on Linux.

Transform
Corner-Pin Aliased Image
The image was aliased when using corner-pin. It was especially noticeable 
when reducing the size of the image and bending it in perspective. The new 
result is now softer, but no longer aliased.

On-Screen Controls Were Always Set To Session Size Boundary
The Transform on-screen controls were not set to the image size. Instead, they 
were set to the session size boundary. This made it awkward to adjust images 
that were larger image than the session.

Parameter Adjustment In Adaptive Update Mode Scaled Image 
To Upper-Left Corner
While adjusting any parameter in Adaptive update mode, the image scaled to 
the upper-left corner.
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 SILHOUETTE 2023.5.1 - 11/20/23
Improvements

Command-Line Output Selection
The command-line renderer previously chose the first Output node it found and 
not the selected one. Now, the selected output node is preferred over the first 
output node unless the -node or -all arguments are used.

OFX Blacklist Now Editable
The blacklist has been moved to a new resources file called config.txt that has 
entries for a global and per-platform OFX plug-in blacklist. They are comma-
separated.

Plug-in Playback Speed In Hosts (Windows)
On Windows, the playback speed of Silhouette within the plug-in host was 
improved.

Stability AI
New Inpaint/Outpaint Default Model 
Changed the default model for Inpaint and Outpaint to Stable Diffusion XL v0.9 
since the Stable Diffusion XL v1.0 model did not produce good edges.

XL Beta v2.2.2 Model Was Added
The Stable Diffusion XL Beta v2.2.2 model was added.

Bug Fixes
Added Legacy Silhouette Paint License To Plug-in Server

The Silhouette plug-in server handles rendering for the plug-in and it did not 
know about legacy Silhouette Paint licenses.
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Cryptomatte
Render Required Output Multi-Part Input 1
Cryptomatte should have rendered with only an input to the data port. However, 
it only worked if there was also an image connected to Input 1 of Output Multi-
Part.

sfxcmd Render Only Rendered Layers (Windows)
On Windows only, rendering Cryptomatte with sfxcmd only rendered layers 
regardless of whether the Silhouette Output Multi-Part node was set to shapes 
or layers+shapes.

GStreamer
Anamorphic Render Not Tagged Properly
Rendering an anamorphic file using GStreamer did not get tagged as 
anamorphic.

Errors In Terminal (Linux)
Errors appeared in the Linux terminal after rendering a GStreamer file.

Interlace Render Was Corrupted (Mac)
On Macs with hardware ProRes encoding, rendering an interlaced movie 
resulted in a zero-byte file.

Multiple of 16 Output Resolution Limitation
The “ProRes width must be a multiple of 16” limitation in GStreamer export has 
been lifted.

Timecode Always Used 00:00:00:00
When the Force Start Timecode was set to a custom value, for instance 
10:00:00:00, 00:00:00.00 was used instead in the rendered file.

Silhouette UI Opened Behind Flame’s Window (Linux)
On Linux only, the Silhouette user interface opened behind Flame’s window.
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Tracker
Planar Tracker > Track Buttons Disabled When Shapes Were 
Selected Inside A Subtract Layer
The Planar Tracker > Track buttons were disabled if add shapes were selected 
in a subtract layer.

Silhouette Crashed While Mocha Tracking Selected Shapes In A 
Subtract Layer and An Add Layer
Silhouette crashed when Mocha tracking selected shapes in a subtract layer 
and an add layer.
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 SILHOUETTE 2023.5 - 11/8/23
Features

After Effects / Premiere Pro Plug-in - Added More Inputs
In addition to the main input and two optional inputs, six more optional inputs 
were added for the After Effects and Premiere Pro plug-ins to facilitate 
compositing in Silhouette.

Denoiser ML - New Models
New v2 Denoiser ML models trained with even more images results in higher 
denoising precision.

Mocha Pro, Particle Illusion and Sapphire > New Versions
Mocha Pro 2023.0.4
Mocha Pro has been updated to 2023.0.4. For a complete list of changes, see: 
Release Notes

Particle Illusion 2023.5.3
Sapphire has been updated to 2023.5.3. For a complete list of features, fixed 
bugs and changes, see: Release Notes

Sapphire 2023.5.3
Sapphire has been updated to 2023.5.3. For a complete list of features, fixed 
bugs and changes, see: Release Notes

New Project Templates
Primatte
Adds a Primatte node, uses the Composite output and for the plug-in, sets the 
host Render parameter to Output: Composite.

Regrain
Adds a Regrain node, uses the Regrained Composite output and for the plug-
in, sets the host Render parameter to Output: Composite.

https://borisfx.com/release-notes/continuum-2023-5-v16-5-3-for-ofx-release-notes/
https://borisfx.com/release-notes/mochapro-2023-10.0.4-release-notes/
https://borisfx.com/release-notes/sapphire-2023-5-3-release-notes/
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Regrain - Automatically Choose Best Sample Area
The Scatter > Sample Box now attempts to automatically find an area of 
sampled grain that does not contain any image detail.

Scripting
port.disconnect() Can Disconnect All Pipes With No arguments
port.disconnect() previously required a port id. If you pass nothing, it now 
removes all connected pipes.

-script_after_args
Previously, sfxcmd -script loaded the project, ran the script and then did other 
command-line processing. However, this didn’t help when the script itself was 
tasked with rendering. With the new -script_after_args command-line flag, the 
script is executed after argument processing.

Trigger Regrain > Analyze Footage With Scripting
The Regrain > Analyze Footage button, along with other buttons, can now be 
triggered with the new Property.trigger() method for Button properties.

Stability
Replaced XL Beta Model With Released XL Model
The Stability XL Beta model was replaced with the newly released XL model. 
The Stable Diffusion XL model is the latest AI image generation model that can 
generate realistic faces, legible text within the images, and better image 
composition, all while using shorter and simpler prompts.

Composite
A Composite parameter was added for the Inpaint and Outpaint modes which 
composites the result using the source alpha and is useful if when blurring the 
alpha’s edge.

Tracking
Mocha - Track Multiple Layers
Multiple, selected layers can now be tracked in the integrated version of Mocha. 
Previously, only the active layer was tracked.
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Track Subtracted Layers
Normally, only the white alpha areas of selected layers were tracked when 
using the Planar and Mocha trackers. Now, to track layers set to subtract, 
enable Track Subtracted Layers. This allows occlusion layers to be tracked at 
the same time as add mode layers.

UpRes ML (New Node)
The UpRes ML node employs machine learning to resize images while 
preserving critical features. To train the upres model, thousands of images 
were utilized, resulting in high quality results.

Purge Cache (OFX Plug-in)
Added a manual Purge Cache button to the OFX plug-in so users can trigger a 
cache purge for the current project if needed.

GStreamer 1.22.6
Silhouette has been updated to GStreamer 1.22.6, which is a versatile media 
handling library for reading various movie file formats.

Changes
Clamp Min/Max Ranges

The Clamp Min/Max parameter ranges where changed to a smaller range: -1 
to 10.

Help > License Menu (Mac)
The Help > License menu was added to the Mac version so deactivation can 
occur without having to use Deactivate Silhouette License in the install folder.

Primate Preview RGB Text Color
The Primate Preview RGB text color was changed to white to be more readable 
on all OS’s.

Stability Models
The Stability 1.x and 2.x models were sunsetted on 11/15/23 so the only model 
you will see now is the Stable Diffusion XL v1.0 model.
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Bug Fixes
EXR’s With Data Window Matching Session Did Not Center

Source Nodes now properly auto-center images with a data window that 
matches the session size.

Nodes
Cross Processing And Curves Crash
Both Curves and Cross Processing crashed if you attempted to adjust the 
curve.

Cryptomatte Render Crashed Silhouette With 0 Opacity Shape
Silhouette crashed if it encountered a 0 opacity shape.

Image Generators With Transform Crash
When adding one of the image generators followed by a Transform and then 
adjusting one of the corner points inward, Silhouette would display an error an 
then crash.

Paint
Auto Paint Frame Start/End Fields With 7+ Digits
When working with a sequence start time of 7 or more digits, the Auto Paint 
frame Start/End fields displayed a number like 1.23457e+07.

Clone - Shift-Right Click
If you Shift-right clicked when using the Clone brush, you couldn’t paint or 
change the cursor in any way.

Switch Matte And Copy Did Not Pass Alpha To Transform
The Switch Matte and Copy nodes did not pass alpha to the Transform node. 
Instead, the Transform node added opaque alpha.

Primatte
Primatte Preview Text Size On Mac
On Retina Mac’s, the Primatte Preview text size was too small.

Console Error When Secondary Spill Was Enabled (Linux)
On Linux, a console CPU error was generated when enabling Secondary Spill.
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Sapphire Generators Required An Input
Sapphire generators like S_Clouds required an input to appear in the viewer.

Switch Matte And Copy Did Not Pass Alpha To Transform
The Switch Matte and Copy nodes did not pass alpha to the Transform node. 
Instead, the Transform node added opaque alpha.

Planar Tracker Tracking Mode
The Planar Tracker tracking mode was set to Auto by default, but actually 
tracked using the last manually set mode.

Plug-in
Copying The Plug-In Within The Host Caused Collisions
Copying the plug-in within the host caused collisions between the instances. 
The result of each plug-in was the same regardless of whether the inputs had 
been changed.

Flame Hang On Exit After Silhouette Is Used (Linux)
On Linux, Flame hung on exit after Silhouette was used.

Movie Files Don't Pass Through To Nuke (Linux)
On Linux, movies loaded in the Silhouette interface will not pass through to 
Nuke.

Multiple Instances of OFX Plug-in Did Not Release Memory
Memory was not releasing when using multiple instances of the Silhouette OFX 
plug-in.

Scripting
Command-Line Renderer Was Not Finalizing Scripting Startup
The command-line renderer was not completing final scripting startup, which 
meant some globals were never set up. The following items were not 
happening in the command-line renderer in Silhouette 2023:

• nodes list added to fx module globals

• import startup
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• from fx import *

• from math import *

object_created Hook No Longer Triggered
A regression as part of the plug-in expression work caused object_created 
hooks to not be triggered.

project.save() Didn’t Work
project.save() didn’t work if the project was already saved.

SFXCMD With Script And No Project Would Not Run Script
Running the command-line renderer with just a script and no project wouldn’t 
run the script. It only worked if it also loaded a project.

User Interface
Data Appeared As An Entry Around Roto Layers In The Timeline
The text Data appeared as an entry above and below Roto layers in the 
Timeline. Data should have been named Children.

Roto > Object List > Duplicate Copies
Duplicate copies of a shape were generated when using Layer > Reset All. The 
duplicates would appear when opening up the project after saving it.
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 SILHOUETTE 2023.0.3 - 7/24/23
Features

Save Project Automatically On Exit Preference
Located in the User Interface preference group, this automatically saves the 
plug-in project on exit of Silhouette. This removes the need to prompt you to 
save when you close the window or select File > Exit.

Bug Fixes
Plug-In Did Not License In Host

When using a plug-in only license, there was a watermark back in the host.

Project Save Dialog Opens When Creating A New Session
The project save dialog opened after creating a new session in a previously 
saved project that contained either a Paint or Stability node. This was an 
unnecessary prompt.
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 SILHOUETTE 2023.0.2 - 7/15/23
Features

Mocha Pro 2023.0.3
Mocha Pro has been updated to 2023.0.3. For a complete list of changes, see: 
Release Notes

Project Management
Silhouette Plug-in Projects Now Stored In Host Project Data
Silhouette projects are now stored within the host application’s project data. 
However, some nodes (Paint and Stability) store sidecar files with the project 
data, and using these nodes will prompt saving the project file to a folder.

To accommodate saving a plug-in project stored within the host application’s 
project data to an external file, the plug-in features an Export Project option in 
the File menu.

Immediately Saving A Project No Longer Required
Silhouette now starts without requiring saving or loading a project. The 
requirement to save the project to a file is now based on whether any nodes 
have been used that require it, for instance, Paint and Stability. 

Helper Text in Sources and Trees Windows
Informative messages in the Sources window explains how media can be 
imported and another message in the Trees window shows how to create a 
session.

hhttps://borisfx.com/release-notes/mochapro-2023-10.0.3-release-notes/
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Bug Fixes
Alpha To Color Node Displayed Color Everywhere

The Alpha To Color Node displayed color everywhere.

Mocha Pro In Silhouette Plug-in
After Effects Crashed On Exit With Mocha Applied (Windows)
On Windows with Mocha Pro applied, After Effects crashed on exit. This issue 
was introduced in 2023.0.1.

Mocha Pro Not Licensed In OFX Host
When used in a Silhouette plug-in project, Mocha was not licensed in the OFX 
host application.To fix this, the plug-in now requires a render license.

Nuke Displayed Black Frames If Playback Was Stopped
With Mocha Pro applied, Nuke displayed sporadic black or corrupted frames 
when playback stopped in the middle of the sequence. This issue was 
introduced in 2023.0.1.

Hang When Exiting SFX With A Floating Window (Linux)
On Linux, when using a floating Silhouette UI window in Nuke, Nuke hangs 
when exiting Silhouette.

Open Shape End Point Adjustment With Multi-Frame
Adjusting the end points of multiple open shapes did not apply to other 
keyframes in multi-frame mode.

GStreamer
Silhouette Crash When Loading JPEG Movie Files (Linux)
Silhouette crashed on Linux when importing JPEG MOV files.

GStreamer Timecode Always Uses 00:00:00:00
When the Force Start Timecode is set to a custom value, for instance 
10:00:00:00, 00:00:00.00 is used instead in the rendered file.
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 SILHOUETTE 2023.0.1 - 6/21/23
Features

Mocha Pro 2023.0.2
Mocha Pro has been updated to 2023.0.2. For a complete list of changes, see: 
Release Notes

Regrain > Grain Output
Added a Grain Only output to the Regrain node so that it could be composited 
separately using the Grain Composite node or within the plug-in host 
application.

Stability - Added The v2.2.2-XL Beta Model
Added the v2.2.2-XL Beta model which produces more photorealistic results.

Expressions
The following expression functions were added.

Noise Functions
• noise(t)

• noise2D(point)

• noise3D(point)

Point 3D Functions
• Point3D.rotate(angle_in_degrees)

• Point3D.normalize()

• Point3D.dot(point)

• Point3D.cross(point)

Variables
• random()

• gaussRandom(min=0, max=1, seed=<current_frame>)

• wiggle (frequency, amplitude, octaves=1, amp_mult=0.5, lacunarity=1.0, 
time=<current_time>)

https://borisfx.com/release-notes/mochapro-2023-10.0.2-release-notes/
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Scripting
Specify Preference Sub-group Via Scripting
You can now set a preference sub-group in preferences created via scripting.

User-defined Color, Point, And Buffer Properties
There was no way to create custom (user-defined) Color, Point, and Buffer 
properties via scripting.

• Color defaults to RGBA but can be overridden by:

prop = Property(id, Color(), info={“type”, “rgb”})

• Point defaults to 2D position but can be overridden by:

prop = Property(id, Point3D(), info={“type”, “size|scale|unit|offset|3D”})

GStreamer 1.22.2 (Windows/Linux)
On Windows and Linux, Silhouette has been updated to GStreamer 1.22.2, 
which is a versatile media handling library for reading various movie file 
formats. The Mac version will updated at a later time.
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Changes
Denoiser ML - Switched Default Model

Switched the default model to Compression+Noise v1.0 as the Camera Noise 
v1 model could produce artifacts in super bright areas with some images.

Regrain > Edge Blend
Edge Blend was revamped so that it no longer blurs grain at the edge of the 
scatter cell pattern.

Stability > Default Generate Model Now Stability v1.5
Changed the default Generate model to Stability v1.5. It produces a more 
accurate result without using negative prompts.

User Interface
Colored Timeline Track Highlighting
Because of the highlighting, when User Interface > Colored Timeline Tracks 
was enabled, it was difficult to see what layer or object was selected. Now, 
there is a crosshatch pattern in the timeline added to the selected object.

ROI Keyframes In Timebar Were Distracting
There ROI keyframes now only appear in the Timebar when The Viewer > ROI 
display is active as they interfered with the selected shape keyframes.

Stability AI Server Preference Removed
The Stability AI Server preference was removed as it is not yet supported.

Transform Filtering
Default Changed To Catmull-Rom
The default Transform node filtering is now set to Catmull-Rom.

Improved Filtering
The quality of the Transform filtering has been improved for all filtering types.
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Bug Fixes
Autodesk Flare Imported Clips As A 0x0 Resolution

Autodesk Flare imported clips as a 0x0 resolution. There was a Flame-specific 
work-around in the code, so it was changed to also look for Flare.

Copied Node Resets Original Node
If you copied and pasted a Transform node and then reset the copied node, the 
original node was also reset.

Film Glow - Empty Group
The empty Secondary Glow > RGB Independent group was removed.

Denoiser ML
Did Not Work With Proxies
The Denoiser ML node did not work with proxies and produced image artifacts.

First and Last Frames
The Denoiser didn’t produce a good result on the first and last frames because 
it required 2 frames before and after the current frame.

Command-Line Hang With Mocha Pro (Windows)
When doing a command-line render with a project containing a Mocha Pro 
node, sfxcmd would hang on exit.

GStreamer (Windows/Linux)
Could Not Read Some 6K ProRes Files
Large dimension ProRes files failed to import.

Draw Issues For HEVC Clips
HEVC clips could display lines when imported into Silhouette.

Internal Error While Reading Video
Stepping backwards with some clips caused an “Internal Error While Reading 
Video” error.
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ProRes Encoded With Adobe Tools Was Not Read Correctly
Clips imported from Media Encoder and some other Adobe exporters would 
sometimes not be imported correctly.

Stuttering Playback For Some H.264 Codecs
Some H.264 codecs stuttered during playback.

Licensing
Command-line Render With Mocha Pro Unlicensed (Windows) 
On Windows, Mocha was not licensed when doing a command-line render.

Mocha Pro Not Licensed - Linux
On Linux, Mocha Pro was not licensing in the Silhouette standalone when using 
a Silhouette only serial number.

port@host Entry Does Not License Embedded Mocha
When a customer enters a port@host in the license window for a floating 
license, the embedded Mocha did not get a license.

Silhouette Didn't Use Boris FX Suite Floating License 
With both Silhouette and Boris FX Suite floating licenses, Silhouette would not 
use the suite license after all Silhouette licenses were used.

Mocha Pro Bezier Shapes Corrupt When Transferred
Bezier shapes transferred from Mocha Pro using the node options were corrupt 
in Silhouette.

Mocha Pro / Planar Trackers > Track Forward 1 Frame
The Track Forward 1 Frame icon did not work with some footage when using 
the Mocha Pro or Planar Tracker.

Morph > Correspondence Lines And Open Shapes 
Using two open shapes, adding a correspondence point only showed 
correspondence lines on half of the open shape.



   Silhouette 2023 What’s New

26 Silhouette 2023.0.1 - 6/21/23

• 
• 
• 
•
•
•

• 
• 
• 
•
•
•

Nuke Export Error
Because of a missing component, some Nuke exports produced an error when 
exporting.

OCIO Colorspace Node Crash
Silhouette crashed after clicking on the OCIO Colorspace > Config field.

Output > Cryptomattte
The Cryptomatte group was removed from the Output node since it is only 
needed in the Output Multi-Part node.

Primatte > Ctrl-Drag Selection
Ctrl-drag selection did not work in Primatte.

Regrain
Analysis Curves
The analysis calculations were clipping values above 1.

Cell Pattern Not Limited To Matte Area
With the Matte enabled, the Overlay Cell Pattern was not limited to the matte 
area.

Matte > Enabled: Grain Did Not Randomize
With the Matte enabled, the grain did not randomize in matte areas where the 
matte value was 0.

Sapphire Filter Caused Insert To Be Repositioned
When a Sapphire filter was placed before a Transform node, the image was not 
in the correct location when doing a Transform > Insert.

Roto - Adjusting Multiple Shape End Points To A Point
Adjusting multiple open shape end points to a point resulted in some points not 
being adjusted.
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Transform
Blurry Sampling
When using corner-pin, the sampling could be blurry at certain settings in 
localized areas.

Insert With Cropped Image
An image cropped using Crop or DOD was not in the correct location when 
doing an insert with the Transform node.

Proxies
Selecting a Viewer Proxy of 2:1, 3:1 or 4:1 cropped the image at the top left of 
the screen.
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 SILHOUETTE 2023 - 4/26/23
Features

New Nodes
Primatte
Using a unique algorithm based on three multi-faceted polyhedrons floating in 
RGB colorspace to isolate color regions, Primatte keys out and replaces blue 
or green screens with transparency to facilitate background replacement. The 
3D Preview display aids in the visualization of the keyed value.

Generative AI and Machine Learning
Stability
Stable Diffusion is a pioneering, deep learning text-to-image model. It is 
primarily used to generate detailed images based on text descriptions. The  
Stability node integrates Stable Diffusion models directly in Silhouette. Inpaint, 
outpaint or generate images from scratch using text prompts.

Denoiser ML
The Denoiser ML node employs sophisticated deep learning techniques to 
eliminate unwanted noise from images while preserving critical features. To 
train the denoising model, numerous images were utilized, resulting in a highly 
effective system. Additionally, the extracted noise can be seamlessly 
reintegrated into the image using the Grain Composite node.

Grain Management
Denoiser ML, Regrain and Sapphire UltraGrain make up the new grain 
management tools in Silhouette.

Regrain
Based on DasGrain by Fabian Holtz, Regrain samples the source image’s 
grain, regenerates and randomizes it for the purpose of adding it back to a 
degrained composite.

Sapphire UltraGrain
Adds simulated digital camera grain to the image.
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Mocha Pro 2023
Roto Improvements
Mocha Pro's Roto tools have new features that make spline adjustments easier 
and more efficient, such as Inner Width feather adjustment, Shrink and Grow 
Splines, Adjust Spline Points with Falloff, Split Contours, Snapshot Duplicate, 
and Double-click Shapes.

Tracking Improvements
Mocha Pro's Tracking tools have new features like Merge Tracks, Grid Scale, 
Adjust Mesh Points with Falloff, and Search Area Mattes.

For a complete list of features, fixed bugs and changes, see: Release Notes

Sapphire 2023.5
Sapphire has been updated to v2023.5. New features include UltraGrain, 
PrismLens and DissolveUltraGlow effects, new lens flare and UltraGlow 
presets, S_Effect parameter linking, and expanded Metal support.

For a complete list of features, fixed bugs and changes, see: Release Notes

Particle Illusion 2023
Particle Illusion has been updated to v2023. Features include new 2023 Emitter 
Library, performance enhancements, and numerous user interface 
improvements. For a complete list of features, fixed bugs and changes, see: 
Release Notes

Atmospheric Glow
Atmospheric Glow is a glow style mega-filter that brings instant atmospheric 
looks to an otherwise flat scene. Based around a film glow, this effect includes 
nine independently controlled groups, including volumetric light rays, a 
smoke/fog generator, light flickering, chromatic aberration, optical orbs, film 
grain and a vignette, each of which adds a new element to the scene.

Curves
Curves adjusts the entire tonal range of an image by changing the shape of 
RGB, Red, Green or Blue curves. Curve points can be adjusted throughout the 
range of shadows to highlights.

https://borisfx.com/release-notes/particle-illusion-standalone-2022-5-v15-5-2-release-notes/
https://borisfx.com/release-notes/mochapro-2023-release-notes/
https://borisfx.com/release-notes/sapphire-2023-5-1-release-notes/
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Expressions
Silhouette offers both scripting and expressions as tools for customizing and 
automating the animation process. While scripting requires programming skills, 
expressions allow artists to create complex animations and link parameters, 
perform math functions, and use variables without having to write code. This 
makes expressions a more accessible option for artists who may not have 
programming skills, while still offering a high degree of control and flexibility.

• Link Parameters In The Same Node

• Link Parameters From Different Nodes

Motion Blur Controller Expression Action
The Create > Motion Blur Controller action creates a Motion Blur node which 
controls all other node’s motion blur settings using expressions. The controller 
includes Enable, Angle, Phase, and Samples parameters, with values 
defaulting to the first motion blur enabled node settings it finds. It then creates 
expressions for all nodes in the tree that have motion blur parameters.

RED R3D Import
Silhouette now supports RED R3D source files.

New Presets
The following nodes now have new presets: Beauty Studio, Camera Shake, 
Chromatic Aberration, Day for Night, Develop, Film Glow, Grunge, Light Leaks, 
Prism, Rays, Smear Blur, Sunset, Two Strip, Vignette, and X-Ray.

Scripting
-args <argument_list>
-args <argument_list> is a new command-line argument where argument_list 
is a comma-separated list of arguments to pass as sys.argv to the script.

SFX_SCRIPT_IMPORTS Environment Variable
The only way to add more script paths that were auto-imported was via prefs. 
Added the SFX_SCRIPT_IMPORTS environment variable that can be a 
delimited set of paths (using : or ; as delimiter). Paths can contain their own 
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environment variables. Any path found in this variable will be imported before 
external scripting paths set in preferences. Paths should be treated as python 
modules with their own __init__.py file.

Improvements
Nodes

Camera Shake
Added a Data input and Transform parameter to choose point trackers and 
tracked layers to match move the image based on the tracking data. This is 
good way to match the camera shake of another image.

Color Correct > Color Wheels Resolution and Layout
The Color Correct color wheels have improved resolution and now appear in 
the Timeline in a horizontal layout. 

Cross Processing / Film Stocks
A curves interface was added to Cross Processing and Film Stocks.

Film Glow
A set of secondary glow parameters was added to create chained glows.

Grunge
An Auto Scale option was added to the Gate Weave section

User Interface
Open Logs Location
Opens the folder containing the Silhouette diagnostic logs.

Parameter Options
Parameters now have an Options menu icon ... to the right of the parameter 
that includes Reset, Insert Key, Delete Key and Copy Expression Reference 
options.
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Point Control > Transform Pop-Up Menu
The point control transform pop-up menus used to select the transform source 
now only appear when the node’s data input is connected and there is a point 
tracker or transformed layer present.

Preset Thumbnail Text Size
The preset thumbnail text now wraps to two lines to accommodate longer 
preset names.

Sources Window Thumbnail Size
The Sources window thumbnail size was increased.

Viewer > Apply Gain/Gamma When Viewing Alpha 
Preference

When enabled, the Viewer Gain and Gamma affect the alpha.

Bug Fixes
Channel Blur Missing

The Channel Blur node was missing.

Depth Node Objects Could Not Be Added
Non-shape depth objects couldn't be added to the Object List.

Lens Flare > Flare Editor Black On Linux
On Linux, the Lens Flare > Flare Editor displayed a black viewer.

Morph Crash
The Morph node crashed with inputs that had an infinite DOD like Color.

Paint > Clone > Vertical Split Issues
Crash With Grade/Filter Blur And Sharpen
Using a DOD set smaller than the Session size before the Paint node, 
Silhouette crashed when Clone > Grade/Filter > Blur and Sharpen were 
adjusted in conjunction with the Vertical Split.
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Black Viewer With Grade/Filter Blur And Sharpen
Using a ROI set smaller than the Session size, the Viewer displayed black 
when Clone > Grade/Filter > Blur and Sharpen were adjusted in conjunction 
with the Vertical Split.

Power Mesh Hang With Mocha Pro Insert Enabled
When the output of the Mocha Pro node with Insert enabled was plugged into 
a PowerMesh node, Silhouette hung and then crashed.

Roto > Outline Size / Fill Opacity Couldn’t Be Keyframed
The Roto > Color > Outline Size and Fill Opacity could not be keyframed.

Sapphire Preset Browser Did Not Open On Linux
The Sapphire Preset Browser did not open on Linux.

Scripting
Command-Line Scripts No Longer Require A Project
A project is no longer required to run a script from the command-line.

Transform Menu & Point Trackers
Selecting a point tracker in the Transform menu had no effect.

User Interface
Font Size Preference Did Not Affect All Text
The User Interface > Font size preference only affected node labels. Now, it 
affects all Silhouette text. 

No Project Open Issues
• With no project loaded, the window title now says "Silhouette (NO PROJECT)".

• You are now prevented from dragging and dropping media files into the Sources 
window when there is not a project opened.

• An error dialog was added if attempting to open a project that didn’t exist.
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